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ArchiCAD MasterTemplate 12.1 Release Notes
April 27, 2009

Welcome to the latest version of the ArchiCAD MasterTemplate. The new update contains many new 
features sprinkled throughout the files, based on feedback and suggestions from users as well as our own 
discoveries and innovations. This document will explain what is new, and outline two different strategies 
for integrating the new features into versions of MasterTemplate that have been customized or developed 
by users.

Here is a short list of what's new:

1) Interactive Legends - greatly expanded with Quick Rooms and Parts Matrixes
2) Legends - FAST access through a Worksheet using Virtual Trace!
3) 3D Views and 3D Windows show many of the Legends for study and easier use
4) Custom Profiles - many new wall profiles show the possibilities
5) New Fills, Materials, Textures and a smart custom Label
6) Layers - a few adjustments, new layers and layer combinations

Each item in this list is explained in great detail later in this document.

Initial Download and Setup
The Release Candidate for the new AMT 12.1 was first posted for download on April 17, 2009, zipped 
into MasterTemplate_12.1_USA_RC1.zip:

• MasterTemplate 12.1 USA TEMPLATE.tpl
• MasterTemplate 12.1 USA LEGENDS.pln
• MasterTemplate 12.1 USA LIBRARY
• AMT Office Favorites.mod
• AMT Project Favorites.mod

To install AMT 12.1, download the zip file to your workstation, then unzip it to a convenient location. All 
the files have new names compared to the previous AMT 12, so you can put them into the same folder; or 
you can create a new folder for them.

The new 12.1 TEMPLATE file uses two Hotlinked Modules (HLM): one refers to the new and greatly 
expanded MasterTemplate 12.1 USA LEGENDS.pln and the other to the new AMT Project 
Favorites.pln. When you open up the TEMPLATE you'll get a message saying that these two Hotlinks 
are missing, since everything is now on a new workstation. Go to the Hotlink Manager (either directly from
that message, or from the File menu > External Content > Hotlink Manager) and relink these two 
references to the file locations on your hard drive or network.

Note that the AMT Office Favorites.mod file is referenced from within the LEGENDS file, so it will still be 
"missing" until you clean that up. Simply open up the LEGENDS file itself and use the Hotlink Manager to 
relink the Office Favorites file for the HLM, then resave the LEGENDS PLN file.

When you open the TEMPLATE file, you will also get a warning about missing PDFs - these are 
referenced in the Layout Book and used for the specifications and general notes pages. As with all 
previous versions of AMT, you can resolve this warning message once and for all by using the Read 
From… button and choosing the MasterTemplate 12.1 USA Library. ArchiCAD will search within the 
library folder and subfolders, and find the PDF files and relink them. Later, when you save the 
TEMPLATE, all of this will be remembered, so you won't have to deal with them again (unless you move 
the files or decide to change the references).
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At this point, you'll have a new version of AMT to explore. We suggest you read through these Release 
Notes to see what's new, then decide how you want to transition your own version of AMT. At the end of 
this document, two approaches will be discussed for how to integrate the new version into your workflow.

Please report anything requiring cleanup in an email to template@bobrow.com. We hope you enjoy the 
new features of AMT 12.1. Thanks again for the opportunity to work with you!

Eric Bobrow
Bobrow Consulting Group
April 27, 2009
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1) Expansion of the Interactive Legends of Visual Favorites
Here is a screenshot of the original set of Interactive Legends in MasterTemplate 12:

There are four groups shown with a pink overlay. These were removed and replaced with expanded 
versions in the new set of Interactive Legends for AMT 12.1:
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Before, there were 13 Legend groups, of which 4 were minimally developed, including one intended to be 
expanded by users ("Your Office Favorites Legend"). Now there are 20 sections, with two intended for 
office customization, and one set up for favorites for the current project.

The original groups have been reorganized somewhat, and now are in the top two rows. The lower two 
rows (which are set against a light yellow background with a dashed outline) include 6 sets of Quick 
Rooms and 3 Parts Matrixes.

• Quick Rooms and Parts Matrixes

The 6 Quick Rooms sections actually 
encompass close to 20 different rooms or 
scenes, including both residential (kitchen, 
bathroom, living room, family room, site, etc.) 
and commercial (offices, restroom, lobby, 
meeting room, etc.) groupings. They are 
intended to be used in a similar way to the 
other Interactive Legends - as a kit of parts 
that you can access with the eye-dropper. 

In addition, it is possible to select entire rooms 
(such as a bathroom, office or restroom) and 
copy the elements to the clipboard, then paste 
them into your project. This will make it easier 
to quickly develop a concept model, defining 
room usage and scale with a coherent set of 
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furniture and fixtures. Of course, you will need to rework them for your actual design requirements, but 
they give you a quick way to take a simple partition plan and "dress it up."

One additional advantage of the 
Quick Rooms is that it is easier to 
see the kit of parts in context, with 
elevation settings already set (for 
example, the upper cabinets in the 
kitchen, and grab bars in the rest 
room are at appropriate heights). 
Also, some library parts that have 
complex parameters and options 
may be understood better when 
seen in context. This is particularly 
interesting for parts such as the 
Commercial Bath Stall 12, which 
can be placed (and is seen in the 
Quick Multiple Occupancy rest 
room) as an entire stall (or multiple 
stalls) with door(s) or just as a 
partition piece.

To make it simpler to understand 
what parts are being used in the 

Quick Rooms, we have labeled all the elements with their actual library part name.

We also added several Parts Matrixes 
with groups of components for 
Residential Kitchens, Public Restrooms, 
and Entourage ornamentation, as well 
as new Legend groups for Structures 
and Complex Wall Profiles. These give 
a much larger and more comprehensive 
set of parts to use in your projects, 
organized in ways that will prove 
convenient and legible.

• Your Office Standards and 
Quick Rooms

If you wish, you can rework the entire 
Legend set. However, to make it simpler 
to manage, we have separated out two 
sections called Your Office Favorites 
Legend and Your Quick Rooms into a 
separate Hotlinked Module file. You will 
see these on the far right side of the 
Interactive Legends in the middle two 
rows (see screen capture on the right), 
visually identified with a shaded 
background and a solid rounded 
rectangle border line.

These legend groups are Hotlinked into 
the main Legend file, and can be edited 
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separately. If you place your own additions to the Legends in this file, if BCG releases an update to the 
rest of the Legends, your customization will automatically be incorporated.

This HLM file is called Office Favorites.mod and is included in the AMT 12.1 download. When you first 
install AMT 12.1, you'll need to open up the MasterTemplate 12.1 USA LEGENDS.PLN file and tell it 
where to find the Office Favorites file, since it has been moved to a new workstation (yours) or server. 
You can do this in the File menu > External Content > Hotlink Manager by clicking the Relink button and 
then browsing for the Office Favorites.MOD on your workstation or server. 

Save the AMT Legend 12.1.PLN, and now you will be all linked up properly. To put things into the Office 
Favorites file, you can simply open the MOD file and rework it, then save it again. Whenever you update 
the Office Favorites, go back and open the AMT Legend 12.1.PLN - you'll get a message that the Hotlinks 
need to be updated - allow ArchiCAD to update the Hotlinked Modules, then resave.

To make it easier to create or add to your favorites or quick rooms, you may find it useful to open up a 
separate session of ArchiCAD and copy elements from an open project file, then paste into the Office 
Favorites. Remember to resave the Favorites file then update the Hotlink in the Legend so you can see 
your updates in every project.

• Project Favorites

For larger projects that require extensive 
development, possibly with multiple team 
members, we have set up a special 
Project Favorites.mod legend file. You'll 
see this in the upper right of the Legends, 
with a pale yellow background.

This is hotlinked directly from the 
template itself rather than from the 
Legends.PLN file. Similar to the Office 
Favorites.mod, you'll need to clean up 
this Hotlink. Open up MasterTemplate 
12.1 USA TEMPLATE.tpl then go to the 
File menu > External Content > Hotlink 
Manager and Relink it. 

When you create a new project from 
MasterTemplate, this hotlink may be left 
alone until you decide whether it is worth 
creating a special Project Favorites file. If 
you want to create one, then open up the 
Project Favorites.mod and Save As a 
copy in the project folder; then Relink 
from the actual project PLN file to this new copy.
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2) FAST Access to the Interactive Legends through a Worksheet
In MasterTemplate 1.0, 1.1 and 12 the Legends were Hotlinked and placed onto the floor plan, and 
accessed from saved Views that jumped to where they were stored. In order for the kit of parts to include 
generic 3D elements (such as walls, floor slabs and roofs) as well as doors and windows, the elements in 
fact have to be placed onto a floor plan. These elements cannot exist in their native form in a 2D drafting 
area such as a Detail or Worksheet window.

Because the Legends are placed on the floor plan, to access them requires leaving the current floor plan 
work area and navigating to the Legend area, while turning on the Master Layer for the Legend Hotlinked 
Module. One double-clicks a View, which jumps to the saved Zoom and also activates a specific layer 
combination that turns on the Master Layer.

The awkward part of this process arises out of the fact that one has to do a number of steps to get back 
to the actual work area. Typically one needed to scroll through the View Map to find the right View (one of 
the Model views or a Construction Document plan view) then either Zoom to Fit in Window and manually 
find the area that was being worked on, or manually change the Layer Combination from the Quick 
Options palette, then choose Previous Zoom one or more times. Keyboard shortcuts were of limited 
usefulness because Views and/or Layer Combinations had to be manually selected each time.

In AMT 12.1, we have dramatically shortened the time required to access the Legends (and return to 
where you were working) by referencing them from a Worksheet using Virtual Trace! 

Here's how it works. There is a new Worksheet called LG-04 INTERACTIVE LEGENDS | PLAN & 3D in 
the Project Map, which has nothing drawn in it. However, we have used Virtual Trace to reference the 
View LEGEND 3D | ALL in the LEGENDS | PLAN folder. While it is common to set up Virtual Trace to 
show the referenced View with a single color (such as blue or red) to make it easy to see what is active 
and what is being traced, we use the option to display the Reference in it's Original Color. This way, it 
looks exactly like the original Legend view. The eye-dropper works just as it did before.

While in the Legend Worksheet one does not need to change the active Layer Combination in order to 
see the (Plan) View of the Legend, so one can leave the Layer Combination unchanged from whatever 
was set in the current workflow. Moreover, one can use a keyboard shortcut to jump to the Last 
Worksheet, so after one accesses the Legend through this Worksheet the first time, one can return with a 
single keystroke. Similarly, to return to the Floor Plan to the current work area and context (Layer 
Combination, Model View etc.) one can simply use the F2 keyboard shortcut. 

One keystroke to get to the Legends, one to get back!

To access the Legend Worksheet the first time, simply go to the Project Map (the left-hand icon at the top 
of the Navigator, next to the View Map icon) and open up the Worksheets section and double-click the 
LG-04 INTERACTIVE LEGENDS | PLAN & 3D entry. Zoom to wherever you need within the worksheet, 
and use the eye-dropper. Return to the Floor Plan by hitting F2. 
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Return later to the Worksheet Legend using the context menu (right-click anywhere in the plan with 
nothing selected, and choose Last Worksheet from the "Go to" submenu) or the "Go" submenu in the 
Mini-Navigator toolbar. 

• Keyboard Shortcuts for the Legend Worksheet (and more)

For fastest access to the Legend Worksheet, you can set up a keyboard shortcut for Last Worksheet. Go 
to the Options menu > Work Environment > Keyboard Shortcuts, and choose from the List popup (in the 
center near the top of the dialog box) "All commands in alphabetical order" then scroll down to "Last 
Worksheet". 

TIP: you can click on any item in the command list, then type the letter "L" to jump down to the 
commands that start with that letter.

Click on the right side where it says "Click here and press desired shortcut keys" then type in a shortcut. 
We recommend Shift-W, i.e. hold down the shift key and type the letter "w". 
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While you are here, you may also find it useful to define shortcuts for the following (keys shown are 
suggested, but you may use whatever you wish):

• Last Detail Drawing: shift-2
• Last 3D Document: shift-3
• Last Interior Elevation: shift-I
• Last Elevation: F8

Once you have defined all the shortcuts you wish, it is a good idea to highlight the Shortcut Schemes (on 
the left-hand side) and save your custom scheme so you will be able to access it later in case you 
accidentally reset your preferences back to the default settings. Once you have saved a Shortcut 
Scheme, you can also export it as an XML file that can be reused on another workstation using the import 
option.

• Additional Shortcuts

Once you are in the Worksheet, you may zoom freely to any part of the Legends. The next time you 
return to the Worksheet, you'll be back at the same place!

You may display the Plan and Worksheet windows at maximum size, so that when you switch between 
them, only the front-most window is seen. However, if you have a large enough monitor, or two monitors, 
you may choose to show the Plan and Worksheet windows side by side (or have one on the main screen, 
and one on a secondary monitor. Then you don't need any keyboard shortcuts, simply click from one 
window to the other.

In the Worksheet, as a time-saving convenience, we 
have set up saved Zooms to go to each area of the 
Legend. Simply press down on the popup triangle 
next to the percent value in the lower left corner of 
the window, and choose from one of the preset 
Zooms.

In addition, there are Views of the Worksheet with 
these Zooms defined in the View Map in the folder 
LEGENDS | WORKSHEET. However, when you use 
these Views, they (by necessity) set the Layer 
Combination (all Views record a Layer Combo, and 
when activated, turn that combo on). Thus, when 
you return to your actual work focus, you'll have to 
manually reset the Layer Combination as needed (or 
use another Model or Construction Document view 
to do that for you).

The original Legends views are still recorded in the 
LEGENDS | PLAN folder in the View Map, but are 
probably no longer needed. If you wish, you may delete all of them EXCEPT the one called LEGEND 3D | 
ALL, which is referenced from the Worksheet using Virtual Trace.
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3) Legends as 3D Views and 3D Documents
In AMT 12.1 we have pioneered another way to view and access the Legends: 3D Views and 3D 
Documents. These are particularly good for understanding and selecting elements from the Quick 
Rooms, and have been set up for the Parts Matrixes as well.

In the View Map, you will find a folder called LEGENDS | 3D VIEWS. If you double-click any of these, you 
will be taken to the 3D Window and see the Quick Room or Parts Matrix. Here (for example) is the 3D 
QUICK KITCHEN VIEW:

The eye-dropper is visible at the base of the bar stool near the popup onscreen display of the element 
information. Since the 3D view can be rotated around freely, it is simple to understand the scene, and 
pick out any desired elements with the eye-dropper.

The saved 3D Views record a Marquee-based clipping excerpt, along with the necessary layer 
combination to see the Legend. After using the eye-dropper, to return to your current work, you'll need to 
double-click on the View you were using (a Model view or a Construction Document view) to return to the 
floor plan with the right layer combination active. You will not need to do anything to return to the zoom 
location on the floor plan, since activating the 3D Legend View did not disturb your place. However, you 
may need to switch stories, if the View you activate is based on a different floor.

• A Couple of Warnings: Z-heights and Home Stories

Unfortunately, there are a few strange things in the way ArchiCAD picks up the element information with 
the eye-dropper in the 3D Window. For reasons we don't fully understand or agree with (and I've checked 
with Graphisoft development to get clarification), the z-height default is kept track of separately for the 
floor plan and the 3D window. This means that when you pick up the settings of an element in the 3D 
Window, then return to the Floor Plan, you will need to double-check the base elevation height. 
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When you eye-drop an upper cabinet, or a microwave, blender or other element on top of the counter, 
you will not be able to place them automatically into your kitchen at the right base height. You will have to 
manually set the elevation when you return to the floor plan. In fact, if the last element you placed in the 
plan is off the floor (such as an upper cabinet), then you go to the 3D Window (to access one of these 
Quick Room Legends, for example) and eye-drop a base cabinet - be careful when you return to the plan 
- since when you place the base cabinet it will be up at the raised z-height unless you manually change it.

One more troubling issue comes up when one is working on a story other than the ground floor, then 
activates the View to access a Legend in the 3D Window. When one eye-drops the element, ArchiCAD 
records that the element is on a different story than the active story. It actually records the story 
displacement - for example, that the home story for the bathroom fixture is one story below the active 
story. 

Then, when one goes back to the floor plan to place the 
fixture, it gives an error message (see image at right). 

Even though one clicks on the plan of a particular story, 
the element is being placed onto a different one! The only 
way to get around this issue is to open up the element 
settings BEFORE placing it, and manually change the 
Home Story to the current one. If you've already got the 
error message, simply hit the Undo button, then correct 
the Home Story setting and click to place the object again.

NOTE: This problem only happens when working on a different story than the Legend elements. 
This is why we have moved the Interactive Legends to the Ground Floor in AMT 12.1, rather than 
the story below that as in AMT 12 and earlier. This allows the issue to be avoided while working 
on the Ground Floor.

These idiosyncrasies are a nuisance, but they come up only in a small percentage of cases and can be 
worked around. The benefits of using a 3D View to access the Legends are often worth it.

• 3D Documents as Legends

As a further extension of the concept, we have introduced 3D Document views of many of the Quick 
Rooms, located in the folder LEGENDS | 3D DOCUMENTS. The eye-dropper can be used in the same 
way as in the 3D Window-based views.

There are trade-offs when using the 3D Document approach. One of the benefits is that the 3D Document 
will come up almost instantly when called, since we have saved these windows with the Manual Rebuild 
option. They also are independent of the 3D Window, and can be opened using the context menu or 
keyboard shortcut for Last 3D Document (see keyboard shortcut section above). If desired, labels and 
other annotation can be drawn into the 3D Document for clarity.

Since unlike the 3D Window, one cannot spin around a 3D Document, we put in some of the walls for the 
Quick Rooms on a layer set to Wireframe. This allows elements on the other side of these walls to be 
seen, and even eye-dropped right through the wireframe element.

When eye-dropping from a 3D Document, there is no problem in picking up the default z-height; when 
you return to the floor plan, the appropriate z-height is properly set.

However, the issue concerning the Home Story (described above) does occur. If you are working on a 
story other than the Ground Floor, and you eye-drop from a 3D Document an element that is based on 
the Ground Floor, the default Home Story will be recorded as an offset from the current story. You'll have 
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to correct this before placing the element on the plan, otherwise you'll get the same error message shown 
above.

The other slight issue with 3D Documents is that they take up a fair amount of storage in the file. Each 
Quick Room grouping when saved as a 3D Document adds about 1 megabyte to the file size. This 
contrasts with what happens when one saves a View in the View Map for the 3D Window: there is no 
noticeable increase in file size. For this reason, we have opted to only have five of the 3D Documents in 
MasterTemplate. You can add more if you wish, of course.
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4) New Custom Wall Profiles
We'd like to thank two of our clients, Jonathan Davis and Joseph Harouni, for supplying us with 
interesting custom profiles they developed for walls and footings. 

These may be seen and studied in the Legend area called 3D STRUCTURES & PROFILE WALLS. 
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In some of the profiles, there are voids created for floor slabs or ceiling slabs to fit into. Example slabs
(drawn as polygon wedges) are shown in the Legend using the Wireframe layer option:

The walls pictured above actually have framing, waterproofing, channels and additional detail typical of 
concrete tilt-up construction. When a section cut is made through these walls, it generates a very realistic 
drawing:

While these exact walls will not likely be 
perfect for your design, they are 
excellent examples of what is possible. 
Study them and learn how to make your 
own!

You may look at how they are defined 
by using the Design menu > Custom 
Profiles > Profile Manager. Most of the 
new profile walls have names that start 
with an asterisk, such as * WALL | 
Cement Panel Div. + Parapet. 

One trick that is used to create the framing with an "X" is to draw each rectangular 
piece of lumber out of 4 triangular Fill elements, using differently named Fills. If two 
Fills are touching each other side by side, and have the same name (e.g. Empty Fill), 
then ArchiCAD will remove the line between them when a Section drawing is 
generated. (This is generally a good idea, since it allows multiple elements to be 
stacked yet appear to be a single piece, for example, of concrete.) 

To keep the lines of the "X" visible, each Fill uses a different name: Empty Fill 1, 
Empty Fill 2, Empty Fill 3, etc. These Fills were created in the Options menu > 
Element Attributes > Fill Types using the New button, then choosing Duplicate to 
create in identical fill (in this case, empty) but with a new name.
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The Custom Profiles for many of these walls have been set up with the Core and Finishes defined for use 
with Partial Structure Display. Check out how this works by changing the Partial Structure Display setting
using the Document menu or Quick Options palette:
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5) New Fills, Materials, Textures & Smart Label Object
Since the various Empty Fills (above) are already defined for use with the Profile Walls, for your own work 
you won't have to create them - they already are in the Fill list.

These are the Fills added into MasterTemplate 12.1:

• Empty Fill 1
• Empty Fill 2
• Empty Fill 3
• Empty Fill 4
• Concrete Structural
• 09 | Stucco

A number of new Materials have been added as well:

• Wd-WOOD
• Mtl-CORRUGATED STEEL
• Ext-POURED CONCRETE BOARDS
• Wd-FIBERBOARD
• CONCRETE PANEL
• Ext-POURED CONCRETE
• Wd-DECK
• Wd-Pine

You'll see most of these materials in use in the Profiled Walls Legend.

There are a number of texture files supplied for carpets in AMT 12.1. You'll see these in use in some of 
the Quick Rooms:
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These texture files are located in the AMT 12.1 Library folder inside the folder AMT 12.1 Parts.

• New Custom Label

In addition, to facilitate labeling the Quick Rooms and Parts Matrixes Legends, we created a new custom 
Label part. You'll find this in the AMT 12.1 Parts folder. Since it is a Label, you access it using the Label 
tool rather than the Object tool.

There are a few things that are special about this new Label. When used as an automatic label for an 
object, it has an option to show the Library Part name (the original version can show the ID or custom text 
only). In addition, it has a number of text framing choices: rounded rectangle, pointed lozenge shape, 
simple rectangle, or no frame around the text. 

This Label can be placed with or without a leader line. To turn off the leader line, check the parameter to 
Use Label Arrow. 

We added this new Label (with all its variations) to the LEGEND 2D | DOCUMENTATION in the LABELS | 
ARROWS | DIMENSIONS area:
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You can use the eye-dropper to pick up the settings of the Label and place new Labels just like the 
samples in the Legend. However, to use these settings for automatic labeling (ones that are linked to an 
object, and can therefore pick up and display the Library Part name for the object), one has to do a 
couple of extra steps.

Pick any object and then check the box Label Elements (available in the Info palette or the Object 
Settings dialog box):

This will place a Label for this object onto the plan using the default settings for object labeling (which will 
probably not be the new label type). Then (assuming you have already eye-dropped the desired label 
style from the Legend) use the syringe to inject the desired settings into the label that was drawn for that 
object. This should make it look the way you chose, although it won't yet affect the default for automatic 
labeling. 

To finish this task off, use the eye-dropper to pick up the settings for the object itself. This will also pick up 
the settings for the associated label for the next time an automatic label is generated.
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NOTE: When eye-dropping an object, if it has an attached (associated) label, the checkbox for 
automatic labeling will be turned on. This means that when placing a new instance of the 
element, a label will be generated. This is true even if the layer for the label (which is independent 
of the object itself) is turned off. 

For this reason, in the new Quick Rooms and Part Matrixes, after we used the new label object to 
annotate the legends, we selected all the labels and exploded them (Edit menu > Reshape > 
Explode into Current View). Now they are just lines and text! When eye-dropping the objects in 
the Legend, the checkbox for automatic labeling is not turned on, which is much better for general 
use.
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6) Layer Changes
We have added a few layers and adjusted the Layer Combinations slightly. We proceeded cautiously in 
this area since it can affect the functionality of the Template significantly.

Here is a list of the new layers with a brief description of their use:

A | WALL | PARTITION.3D Additional category beyond EXTERIOR and INTERIOR
Z | WIREFRAME.Z Place model elements on this layer for Wireframe effect 

in 3D
U | DRAWING | PLAN | SMALL SCALE.UNIQ For annotation to be seen on smaller scale drawings

ArchiCAD - master only For compatibility with Cadimage Tools - it is only used 
for Master Layouts, for their Key Notes tool

A-WALL-EXTR [This is a mistake in AMT 12.1 RC1 and should be 
removed]

Some of the Layer Combinations have been adjusted:

CONDOC | FLOOR PLAN - SMALL SCALE This now turns on 
U | DRAWING | PLAN | SMALL SCALE.UNIQ 
and turns off 
U | DRAWING | PLAN + SECTION + ELEVATION.UNIQ

* INTERACTIVE LEGENDS This turns on all Layers (except for the Z | TRASH -
RECYCLE BIN and ArchiCAD - master only), and leaves 
the Wireframe layer set for Wireframe in 3D
[needs correction in RC1 for SMALL SCALE layer]

There is one new layer combination:

* INTERACTIVE LEGENDS (NO WIREFRAME) This is used for the Interactive Legends, and turns off 
the Wireframe effect for the special Wireframe layer

There have been requests for two other types of layer adjustments which we will consider for future 
updates to MasterTemplate:

1) A simplified set of layers for use on small projects
2) Additional layers for MEP and Structural use
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Integrating MasterTemplate 12.1 and Your Existing Template
There are two basic approaches for integrating the new version of the ArchiCAD MasterTemplate with 
customized templates created on earlier versions.

1) Start over with the new ArchiCAD MasterTemplate 12.1, and customize it again. This approach is 
ideal for users who have not done much customization to MasterTemplate.

2) Add the new components of AMT 12.1 to your existing template. This is best for experienced 
users who have done a lot of customization that they don't want to repeat.

• How to Integrate Previous Customization into the New MasterTemplate 12.1

The simplest way to reuse what you have done previously is to open up two sessions of ArchiCAD. In one 
of them, open the MasterTemplate 12.1 TEMPLATE.tpl file; in the other, your custom version of the 
MasterTemplate 12 TEMPLATE.tpl file (Note: you may have named this differently, since it is your 
personal or office version).

We suggest you immediately Save As the AMT 12.1 TEMPLATE under a new name specific to your 
office, so that you don't overwrite the standard base version of the template in case you need to access it 
again. Choose the option to Save As an ArchiCAD Template (TPL format) so that the file will be usable as 
a Template file rather than as a PLN project file.

Layout Masters

You most likely have adjusted some or all of the Layout Masters. In AMT 12, go to the Layout Book and 
open up the Masters folder, then double-click on the first Master that you have customized to open it up. 
Activate the Arrow tool (if it's not already) and Select All (CTRL-A or CMD-A), then Copy to the Clipboard. 
Switch to AMT 12.1 (the other session of ArchiCAD) and find the same Layout Master; Select All and 
Delete the contents; then Paste in the contents that you Copied from the AMT 12 file.

Repeat this for each Layout Master that has been customized. If you deleted any Layout Masters in AMT 
12 in order to shorten your Master list, you may want to delete the corresponding ones in AMT 12.1.

Schedules

If you have added or customized Schedules in AMT 12, you can save these as XML files that can be 
imported into your AMT 12.1 template. Double-click one of the entries in the Project Map > Schedules > 
Element list. Click the Scheme Settings… button and review the Schemes listed, and highlight one that is 
new or revised. Click the Export… button to save as an XML file; choose a folder to store it that you'll be 
able to locate easily, and give it an appropriate name. Repeat the Export action for each schedule in the 
list you want to transfer.

Switch to the AMT 12.1 file, and open up one of the Schedules, then click the Scheme Settings… button. 
Click the Import… button and locate the folder in which you saved the XML files. Choose the first one and 
Import it. Repeat for each one in the folder. 

You may find you have redundant schedules: ones from AMT 12.1 with the same names as those you
imported from your AMT 12 file. Review each pair of schedules that has duplicate names and figure out 
which one is "yours", then use the Delete button to get rid of the other.

On each Layout with a Schedule that refers to one that you have Deleted and replaced, select the 
Schedule and right-click, then choose Link Drawing To. Choose the option at the top for "an internal View" 
then select the appropriate Schedule from the SCHEDULES (CLONE) folder.

Element Attributes (Materials, Fills, Composites / Wall Types, etc.)
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If there are any Attributes you have added, such as Materials, Fills, Composites / Wall Types, etc., you 
can use Attribute Manager to transfer them. 

In the AMT 12.1 file, open the Options menu > Element Attributes > Attribute Manager. Then on the right 
side of the Attribute Manager dialog box, click the Open… button and browse for your custom AMT 12 
Template. 

You will be able to select Materials, Fills, Wall Types, etc. from the right side file (your previous template), 
and Append them to the left side (the new AMT 12.1 file you are customizing). Do not use the Overwrite 
button unless you know exactly what this means and feel that it is appropriate.

Other Customization

There are many ways to customize MasterTemplate. If you choose to follow this method (transferring your 
custom elements manually from your old Template to the new Template file), you will have to go through 
your AMT 12 Template manually and copy each element or area that you've modified, then go back to the 
AMT 12.1 file and paste them in.

Remember that you do not have to get this "perfect" in one session. You should retain the old Template 
file in case you need to access it later. You can always go back and get something you missed.

• How to Integrate the New MasterTemplate 12.1 Features into Your Highly 
Customized MasterTemplate 12 File

If you are an experienced user and have done a lot of customization to MasterTemplate, you may prefer 
to add to your existing template some or all of the new features of AMT 12.1. That way you can choose 
exactly what you wish to add or change.

We suggest you review the new features outlined in these Release Notes carefully to understand what 
has been added or modified in AMT 12.1. Open up the standard AMT 12.1 Template and study it, and 
see how all the new things work. Then choose what you want to add to your own template, and use 
methods similar to the previous section to transfer what you wish.

Interactive Legends

To take advantage of the expanded Interactive Legends, open up the AMT 12.1 LEGEND file and copy 
the lower two rows, which contain the new Quick Rooms and Parts Matrixes. Paste them into your own 
version of the Legends, and rearrange the Legend group positions as desired. You may or may not want 
to use the concept of an Office Favorites HLM module separate from the main Legend PLN file.

In addition, in the Template itself, you may choose whether to add the Project Favorites module to the 
Legend area.

If you want to use the concept of 3D Views and 3D Documents with your custom Legend, we suggest you 
move the Legend from the -1 Story to the Ground Floor. This will reduce the story offset issue when using 
the eye-dropper on Legend elements in 3D (see the explanation in the section on 3D Views and 3D 
Documents earlier in these Release Notes). You may either Cut the Legends from the -1 Story and then 
Paste them onto the Ground Floor, or delete them from the lower story and place them fresh on the 
Ground Floor.

Legend Views - Plan, Worksheet, 3D

If you move the Legends from one story to another, you will need to recreate the Views of the Legend in 
the View Map that refer to the different sections of the Legend. This is because each View, once created, 
is linked to a specific source location (in this case, the floor plan story) which cannot be changed. Zoom in 



23

on each area of the Legend in its new location (story), and select the Save Current View option from the 
bottom of the View Map, then name the View appropriately.

To use the new Worksheet access for the Legend, simply create a new Independent Worksheet. You 
don't have to draw anything in it. Open this worksheet, and then right-click on the View that refers to the 
Interactive Legend from the Plan, and choose Show as Trace Reference. Then in the Trace and 
Reference palette, choose the option to show the Reference in Original Color.

In this worksheet, to quickly jump to specific areas of the referenced Legend, go to each area of the 
Legend then use the Zoom popup in the bottom left area of the worksheet window (the small triangle next 
to the percentage zoom value), then choose Save Current Zoom… and name it based on the Legend 
section name. Repeat for each zoom you wish to record - perhaps one overall zoom and as many as 20 
individual ones to point to each Legend area.

You may create Views in the View Map for the Worksheet itself, as we did in AMT 12.1, but this is not 
actually necessary. It is better practice to simply open the Worksheet from the Project Map (or using Go 
To Last Worksheet) so that the active Layer Combination is not altered (as would happen when you 
double-click a View). The Zoom popup will give quick access when a different part of the Legend is 
needed.

To create the saved 3D Views of the Legend, activate one of the original (or recreated) Views that goes to 
the Legend on the Plan (not the worksheet version). Then draw a marquee around a section of the 
Legend, and choose Show Selection/Marquee in 3D. That should give you a 3D view of the Legend 
grouping you chose. Orbit around until you get an angle you like. Save as a new View in the View Map, 
and repeat for each Legend area that you wish to access.

You can create your own 3D Documents for these 3D Views of the Legend groupings as well. Once you 
have a 3D View that you wish to use, simply right-click in empty space and choose the Capture Window 
for 3D Document… command. Give it an appropriate name, and it will show up in the Project Map as a 
new 3D Document. You'll need to do one additional step: save the view of the 3D Document in the View 
Map (as usual, clicking the Save Current View button from the bottom of the View Map).

Element Attributes

When you paste in the new Legend either as a whole, or just the Quick Rooms and Parts Matrixes, the 
new Composite Wall Types, Materials, Fills and Layers are brought into the file automatically. You won't 
need to use Attribute Manager to import them.

These should also become available in your Template file when the Legend HLM is updated in the Hotlink 
Manager.

The Layer Combination for SMALL SCALE is not something that will come in during that process. If you 
wish to rework it as we did in AMT 12.1, you may adjust it manually. Other minor adjustments may be 
needed to reconcile the handful of new layers we added.

As noted in the previous section, this process of integration does not need to be done all in one session. 
You may bring in some of the new features of AMT 12.1 into your existing template, then return later to 
pick up others that you missed or have decided to include.

The New Library

As noted earlier, AMT 12.1 supplies a new version of the AMT library. In actuality, the only change is the 
addition of a single folder at the top level of the library called AMT 12.1 Parts. You may simply copy this 
subfolder into your existing AMT Library to gain access to the new smart Label part and additional texture 
files.


